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1.  Introduction 
 

1.1 Additional Module STEEL AISC 

The U.S. Specification for Structural Steel Buildings (ANSI/AISC 360-05 and ANSI/AISC 360-10) de-
termines rules for the design, analysis and construction of steel buildings in the United States 
of America. With the add-on module STEEL AISC from the DLUBAL ENGINEERING SOFTWARE compa-
ny all users obtain a highly efficient and universal tool to design steel structures according to 
this standard. 

All typical designs of load capacity, stability and deformation are carried out in the module 
STEEL AISC. Different actions are taken into account during the load capacity design. The allo-
cation of designed cross-sections into three types (compact, noncompact and slender) makes 
an important part of the design according to the Specification mentioned above. The purpose 
of this classification is to determine the range in which the local buckling in cross-section parts 
limits the load capacity so that the rotational capacity of cross-sections can be verified. Further, 
STEEL AISC automatically calculates the limiting width-to-thickness ratios of compressed parts 
and carries out the classification automatically. 

For the stability design, you can determine for every single member or set of members wheth-
er buckling is possible in the direction of y-axis and/or z-axis. Lateral supports can be added for 
a realistic representation of the structural model. All comparative slendernesses and critical 
stresses are automatically determined by STEEL AISC on the basis of the boundary conditions. 
For the design of lateral torsional buckling, the elastic critical moment that is necessary for the 
design can be either calculated automatically or entered manually. The location where the 
loads are applied, which influences the elastic critical moment, can also be defined in the de-
tailed settings.  

The serviceability limit state has become important for the static calculations of modern civil 
engineering as more and more slender cross-sections are being used. In STEEL AISC, load cas-
es, load combinations and result combinations can be arranged individually to cover the vari-
ous design situations. 

If required, you can use the add-on module to optimize cross-sections and export the modified 
cross-sections to RSTAB. Using the design cases, you can design separate structural compo-
nents in complex structures or analyze variants. 

STEEL AISC is an add-on module integrated in RSTAB. For this reason, the design relevant input 
data is already preset when you have started the module. Subsequent to the design, you can 
use the graphical RSTAB user interface to evaluate the results. Finally, the design process can 
be documented in the global printout report, from determination of internal forces to design. 

We hope you will enjoy working with STEEL AISC. 

Your DLUBAL Team 
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1.2 STEEL AISC Team 
The following people participated in the development of the STEEL AISC module: 

Program Coordinators 
Dipl.-Ing. Georg Dlubal 
Dipl.-Ing. (FH) Younes El Frem 

Ing. Ph.D. Peter Chromiak 

Programmers 
Ing. Zdeněk Kosáček 
Ing. Ph.D. Peter Chromiak 
Ing. Martin Budáč  
Mgr. Petr Oulehle 

Dipl.-Ing. Georg Dlubal 
Dr.-Ing. Jaroslav Lain 
Ing. Zbyněk Zámečník  
DiS. Jiří Šmerák 

Library of Cross-Sections and Materials 
Ing. Ph.D. Jan Rybín 
Stanislav Krytinář 

Jan Brnušák 
 

Design of Program, Dialog Boxes and Icons 
Dipl.-Ing. Georg Dlubal 
MgA. Robert Kolouch 

Ing. Jan Miléř 

Testing and Technical Support 
Ing. Martin Vasek 
Ing. Ph.D. Peter Chromiak 
Dipl.-Ing. (FH) Steffen Clauß 
Dipl.-Ing. (FH) René Flori 
Dipl.-Ing. (FH) Walter Fröhlich 

Dipl.-Ing. (BA) Andreas Niemeier 
Dipl.-Ing. (FH) Walter Rustler 
M. Sc. Dipl.-Ing. (FH) Frank Sonntag 
Dipl.-Ing. (FH) Lukas Sühnel 
Dipl.-Ing. (FH) Robert Vogl 

Manuals, Documentation and Translations 
Ing. Ph.D. Peter Chromiak 
Dipl.-Ing. (FH) Robert Vogl 
Ing. Ladislav Kábrt 

Dipl.-Ing. Frank Faulstich 
Dipl.-Ü. Gundel Pietzcker 

1.3 Using the Manual 
Topics like installation, graphical user interface, results evaluation, and printout are described 
in detail in the manual of the main program RSTAB. The present manual focuses on typical fea-
tures of the add-on module STEEL AISC. 

The descriptions in this manual follow the sequence of the module's input and results tables as 
well as their structure. The text of the manual shows the described buttons in square brackets, 
for example [View mode]. At the same time, they are pictured on the left. Expressions appear-
ing in dialog boxes, tables, and menus are set in italics to clarify the explanations. 

At the end of the manual, you find the index. However, if you don’t find what you are looking 
for, please check our website www.dlubal.com where you can go through our comprehensive 
FAQ pages by selecting particular criteria. 

http://www.dlubal.com/
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1.4 Starting STEEL AISC 
RSTAB provides the following options to start the add-on module STEEL AISC. 

Menu 
To start the program in the RSTAB menu bar, click 

Add-on Modules → Design - Steel → STEEL AISC. 

 

Figure 1.1: Main Menu: Additional Modules → Design - Steel → STEEL AISC 

Navigator 
You can also start the add-on module in the Data navigator by clicking 

Add-on Modules → STEEL AISC. 

 

Figure 1.2: Data Navigator: Add-on Modules → STEEL AISC 
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Panel 
If results from STEEL AISC are already available in the RSTAB model, you can also open the de-
sign module in the panel: 

Set the relevant STEEL AISC design case in the load case list of the RSTAB toolbar. Use the but-
ton [Show Results] to display the design criterion on the members graphically. 

When the results display is activated, the panel is available, too. Now you can click [STEEL AISC] 
in the panel to open the module. 

           
Figure 1.3: Panel button [STEEL AISC] 
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2. Input Data 
When you have started the add-on module, a new window opens. In this window, a Navigator 
is displayed on the left, managing the tables that can be currently selected. The drop-down list 
above the navigator contains the design cases (see chapter 7.1, page 49). 

The design relevant data is defined in several input tables. When you open STEEL AISC for the 
first time, the following parameters are imported automatically: 

• Members and sets of members 

• Load cases, load combinations, result combinations, and super combinations 

• Materials 

• Cross-sections 

• Effective lengths 

• Internal forces (in background, if calculated) 

To select a table, click the corresponding entry in the navigator. To set the previous or next in-
put table, use the buttons shown on the left. You can also use the function keys to select the 
next [F2] or previous [F3] table. 

Click [OK] to save the results. Thus you exit STEEL AISC and return to the main program. If you 
click [Cancel], you exit the module but without saving the data. 

2.1 General Data 
In table 1.1 General Data, you select the members, sets of members, and actions that you want 
to design. The tabs are managing the load cases, load combinations, result combinations and 
super combinations for the different designs. 

 
Figure 2.1: Table 1.1 General Data 
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Design of 

 
Figure 2.2: Design of members and sets of members 

The design can be carried out for Members as well as for Sets of Members. If you want to design 
only selected objects, clear the All check box: Then you can access the input fields to enter the 
numbers of the relevant members or sets of members. The list of the numbers preset in the 
field can be selected by double-clicking and overwritten by entering the data manually. Click 
[] to select the objects graphically in the RSTAB work window. 

When you design a set of members, the program determines the extreme values of the de-
signs of all members contained in the set of members and takes into account the boundary 
conditions of connected members for the stability analysis. The results are shown in the result 
table 2.3 Design by Set of Members, 3.2 Governing Internal Forces by Set of Members, and 4.2 Parts 
List by Set of Members. 

Click [New] to create a new set of members. The dialog box that you already know from RSTAB 
appears where you can specify the parameters for a set of members. 

Design according to 

 
Figure 2.3: Design according to standard 

The options of the list box control whether the analysis is carried out according to the provi-
sions of the Allowable Strength Design (ASD) or the Load and Resistance Factor Design (LRFD). 
There are design methods available for both ANSI/AISC 360-05 and ANSI/AISC 360-10. 
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2.1.1 Ultimate Limit State 

 
Figure 2.4: Table 1.1 General Data, Ultimate Limit State tab 

Existing Load Cases and Combinations 
In this column, all load cases, load combinations, result combinations and super combinations 
created in RSTAB are listed.  

Click [] to transfer selected entries to the list Selected for Design on the right side. You can also 
double-click the items. To transfer the complete list to the right, click []. 

To transfer multiple entries of load cases, click the entries while pressing the [Ctrl] key, as 
common for Windows applications. Thus, you can transfer several load cases at the same time. 

Load cases marked by an asterisk (*), like load case 8 in Figure 2.4, cannot be designed: This 
happens when the load cases are defined without any load data or the load cases contain only 
imperfections. When you transfer the load cases, a corresponding warning appears. 

At the end of the list, several filter options are available. They will help you assign the entries 
sorted according to load cases, load combinations, or action categories. The buttons are re-
served for the following functions: 

 
Select all cases in the list. 

 
Invert selection of load cases. 

Table 2.1: Buttons in the tab Ultimate Limit State 

Selected for Design 
The column on the right lists the load cases as well as the load and result combinations select-
ed for design. To remove selected items from the list, click [] or double-click the entries. To 
transfer the entire list to the left, click []. 

The design of an enveloping max/min result combination is performed faster than the design 
of all contained load cases and load combinations. However, the analysis of a result combina-
tion has also disadvantages: First, the influence of the contained loads is difficult to discern. 

 

Result  
combination 
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Second, for the determination of the elastic critical moment for lateral-torsional buckling, the 
envelope of the moment distributions is analyzed, from which the most unfavorable distribu-
tion (max or min) is taken. However, this distribution only rarely reflects the moment distribu-
tion in the individual load combinations. Thus, in the case of a RC design, more unfavorable 
values for the elastic critical moment are to be expected, leading to higher ratios. 

Result combinations should be selected for design only for dynamic combinations. For "usual" 
combinations, load combinations are recommended. 

2.1.2 Serviceability Limit State 

 
Figure 2.5: Table 1.1 General Data, Serviceability Limit State tab 

Existing Load Cases and Combinations 
This section lists all load cases, load combinations, and result combinations created in RSTAB. 

Selected for Design 
Load cases, load combinations, and result combinations can be added or removed, as de-
scribed in chapter 2.1.1. 

The limit values of the deformations are controlled by the settings in the Details dialog box 
(see Figure 3.1, page 28) which you can call up by clicking the [Details] button. 

In the table 1.10 Serviceability Data, the reference lengths decisive for the deformation check 
are managed (see chapter 2.10, page 27). 
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2.2 Materials 
The table consists of two parts. In the upper part, all materials created in RSTAB are listed. In 
the Material Properties section, the properties of the current material, that is, the table row cur-
rently selected in the upper section, are displayed. 

 
Figure 2.6: Table 1.2 Materials 

Materials that will not be used in the design are dimmed. Materials that are not allowed are 
highlighted in red. Modified materials are displayed in blue. 

The material properties required for the determination of internal forces are described in chap-
ter 4.2 of the RSTAB manual (Main Properties). The material properties required for design are 
stored in the global material library. The values are preset (Additional Properties). 

To adjust the units and decimal places of material properties and stresses, select in the mod-
ule's menu Settings → Units and Decimal Places (see chapter 7.3, page 53). 

Material Description 
The materials defined in RSTAB are already preset, but it is always possible to modify them: To 
select the field, click the material in column A. Then click [] or press function key [F7] to open 
the material list. 

 
Figure 2.7: List of materials 
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According to the design concept of the ANSI/AISC 360-05 and ANSI/AISC 360-10 standards, 
you can select only materials of the “Steel” category. 

When you have imported a material, the design relevant Material Properties are updated. 

If you change the material description manually and the entry is stored in the material library, 
STEEL AISC will import the material properties, too. 

Principally, it is not possible to edit the material properties in the add-on module STEEL AISC. 

Material Library 
Numerous materials are already available in the library. To open the corresponding dialog box, 
click 

Edit → Material Library 

or use the button shown on the left. 

 
Figure 2.8: Dialog box Material Library 

In the Filter section, Steel is preset as material category. Select the material quality that you 
want to use for the design in the list Material to Select. The corresponding properties can be 
checked in the dialog section below. 

Click [OK] or [↵] to transfer the selected material to table 1.2 of the add-on module STEEL AISC. 

Chapter 4.2 in the RSTAB manual describes in detail how materials can be filtered, added, or 
rearranged. 

You can also select material categories like Cast Iron or Stainless Steel. Please check, however, 
whether these materials are covered by the design concept of the ANSI/AISC 360-05 or 360-10 
standards.  
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2.3 Cross-Sections 
This table manages the cross-sections used for design. In addition, the table allows you to 
specify optimization parameters. 

Coordinate System 

The sectional coordinate system yz of STEEL AISC corresponds to the one of RSTAB (see image 
in Figure 2.9). The y-axis is the major principal axis of the cross-section, the z-axis the minor  
axis. This coordinate system is used for both the input data and the results. 

 
Figure 2.9: Table 1.3 Cross-Sections 

Cross-Section Description 
The cross-sections defined in RSTAB are preset together with the assigned material numbers. 

If you want to modify a cross-section, click the entry in column B to select this field. Click 
[Cross-section Library] or [...] in the field or press function key [F7] to open the cross-section  
table of the current input field (see the following figure). 

In this dialog box, you can select a different cross-section or a different cross-section table. To 
select a different cross-section category, click [Back to cross-section library] to access the gen-
eral cross-section library. 

Chapter 4.3 of the RSTAB manual describes how cross-sections can be selected from the library. 
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Figure 2.10: IS cross-sections in the cross-section library 

The new cross-section description can be entered in the input field directly. If the data base 
contains an entry, STEEL AISC imports these cross-section parameters, too. 

A modified cross-section will be highlighted in blue. 

If cross-sections set in STEEL AISC are different from the ones used in RSTAB, both cross-
sections are displayed in the graphic in the right part of the table. The designs will be per-
formed with the internal forces from RSTAB for the cross-section selected in STEEL AISC. 

HSS cross-sections can only be designed if the thicknesses of web and flanges are the same. If they 
are different, footnote 1004) Non-permissible cross-section type of ‘Rectangular HSS’ is shown. 

Cross-Section Type for Classification 
The cross-section type used for the classification is displayed (e.g. I-shape rolled, welded, box, 
round bar etc.) Cross-sections that are not covered by this table are classified as General. 

Max. Design Ratio 
This table column is displayed only after the calculation. It is a decision support for the optimi-
zation. By means of the displayed design ratio and colored relation scales, you can see which 
cross-sections are little utilized and thus oversized, or overloaded and thus undersized. 

Optimize 
You can optimize every cross-section from the library: For the RSTAB internal forces, the pro-
gram searches the cross-section in the same table that comes as close as possible to a user-
defined maximum ratio. The maximum ratio can be defined in the Details dialog box (see  
Figure 3.1, page 28). 

If you want to optimize a cross-section, open the drop-down list in column D or E and select 
the desired entry: From Current Row or, if available, From favorites 'Description'. Recommenda-
tions for the cross-section optimization can be found in chapter 7.2 on page 51. 
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Remark 
This column shows remarks in the form of footers that are described in detail below the cross-
section list. 

A warning might appear before the calculation: Incorrect type of cross-section! This means that 
there is a cross-section that is not registered in the data base. This may be a user-defined cross-
section, or a SHAPE-THIN cross-section that has not been calculated yet. To select an appropri-
ate cross-section for design, click [Library] (see description after Figure 2.9). 

Member with tapered cross-section 
For tapered members with different cross-sections at the member start and member end, the 
module displays both cross-section numbers in two tables, in accordance with the definition in 
RSTAB. 

STEEL AISC also designs tapered members, provided that the cross-section at the member's 
start has the same number of stress points as the cross-section at the member end. The normal 
stresses, for example, are determined from the moments of inertia and the centroidal distanc-
es of the stress points. If the start and the end cross-section of a tapered member have not the 
same number of stress points, the intermediate values cannot be interpolated. The calculation 
is neither possible in RSTAB nor in STEEL AISC. 

The cross-section's stress points including numbering can also be checked graphically: Select 
the cross-section in table 1.3 and click [Info]. The dialog box shown in Figure 2.11 appears. 

Info About Cross-Section 
In the dialog box Info About Cross-Section, you can view the cross-section properties, stress 
points and c/t-parts. 

 
Figure 2.11: Dialog box Info about Cross-Section 

In the right part of the dialog box, the currently selected cross-section is displayed. 
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The buttons below the graphic are reserved for the following functions: 

 

 

Table 2.2: Buttons of cross-section graphic 

Click [Details] to call up detailed information on stress points (distance to center of gravity, 
statical moments of area, normalized warping constants etc.) and c/t-parts. 

 
Figure 2.12: Dialog box Stress Points of W 16x57 

Button Function 

 
Displays or hides the stress points 

 
Displays or hides the c/t-parts 

 
Displays or hides the numbering of stress points or c/t-parts 

 
Displays or hides the details of the stress points or c/t-parts (see Figure 2.12) 

 
Displays or hides the dimensions of the cross-section 

 
Displays or hides the principal axes of the cross-section 

 
Resets the full view of the cross-section graphic 
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2.4 Lateral Intermediate Supports 

In table 1.4, you can define lateral intermediate supports for members. STEEL AISC always as-
sumes this kind of support to be perpendicular to the cross-section's minor axis z (see (see Fig-
ure 2.9). Thus, it is possible to influence the members' effective lengths which are important for 
the design of column buckling and lateral torsional buckling. 

For the calculation, all lateral intermediate supports are considered as forked supports. 

 
Figure 2.13: Table 1.4 Lateral Intermediate Supports 

In the upper part of the table, you can assign up to nine lateral supports for each member. The 
lower table part shows you a summary of the data entered for the member selected above. 

If the check box Relatively (0 … 1) is selected, the support points can be defined by relative-
input. The positions of the intermediate supports are determined from the member length 
and the relative distances from the member start. When the check box Relatively (0 ... 1) is 
cleared, you can define the distances manually in the upper table. 

In case of cantilevers, avoid intermediate supports, as such supports divide the member in 
segments. Thus for cantilevered beams, this would results in segments that are forked sup-
ported on one side and thus statically underdetermined (forked support respectively on one 
end only). 
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2.5 Effective Lengths - Members 
The table 1.5 consists of two parts. In the upper table, the effective length factors Ky and Kz, the 
effective lengths Ky L and Kz L, the Torsional Buckling effective length factors Kx and the effective 
lengths Kx L for torsional buckling are listed for every member. The effective lengths defined in 
RSTAB are already preset. In the section Settings, further information is shown about the mem-
ber whose row is selected in the upper section. 

Click the button [] to select a member graphically and to show its row. 

Changes can be made in the table as well as in the Settings tree. 

 
Figure 2.14: Table 1.5 Effective Lengths - Members 

The effective lengths for the column buckling about the minor principal axis and the effective 
lengths for torsional buckling are aligned automatically with the entries of table 1.4 Lateral  
Intermediate Supports. If lateral intermediate supports are dividing the member into member 
segments of different lengths, the program displays no value in the table columns G and J of 
table 1.5. 

The effective lengths can be entered manually in the table and in the Settings tree, or defined 
graphically by clicking the button [...] in the work window. This button is enabled when you 
click in the input field. 

The Settings tree manages the following parameters: 

• Cross-section 

• Length (actual length of the member) 

• Buckling Possible (cf column A)  

• Buckling About Major Axis y Possible (buckling lengths, cf columns B - D) 

• Buckling About Minor Axis z Possible (buckling lengths, cf columns E - G) 

• Torsional Buckling Possible (buckling lengths, cf columns H - J) 

• Lateral-Torsional Buckling Possible (cf column K) 
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It is also possible to modify the Effective Length Factors in the relevant directions and decide 
whether the buckling design is to be executed. When a buckling length factor is modified, the 
equivalent member length will be adjusted automatically, and vice versa. 

The buckling length of a member can also be defined in a dialog box that can be accessed by 
clicking the button shown on the left. The button is located below the table.  

 
Figure 2.15: Dialog box Select Effective Length Factor 

In this dialog box, the Theoretical or Recommended values of the K factor can be defined that 
are to be assigned to the selected member or group of members. The theoretical and the rec-
ommended values are described in [3] on page 240. Generally, it is possible to select prede-
fined K factors or to enter User-defined values. 

If a RSBUCK case calculated according to the eigenvalue analysis is already available, you can 
also select a Buckling Shape to determine the factor.  

Buckling Possible 
A stability analysis for buckling and lateral buckling requires the ability of members to absorb 
compressive forces. Therefore, members for which such absorption is not possible because of 
the member type (for example tension members, elastic foundations, rigid connections) are 
excluded from design in the first place. The corresponding rows appear dimmed and a note is 
indicated in the Comment column. 

The column Buckling Possible enables you to classify specific members as compression ones or, 
alternatively, to exclude them from the design according to Chapter E. Hence, the check boxes 
in column A and also in table Settings for Member No. control whether the input options for the 
buckling length parameters are accessible for a member.  
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Buckling About Axis y resp. Axis z 
With the check boxes in the Possible table columns, you decide whether a member has a risk of 
buckling about the axis y and/or z. The axis y represents the "major" principal member axis, the 
axis z the "minor" principal member axis. The effective length factors K,y and K,z for buckling 
about the major or the minor axis can be selected freely The effective length factors Ky and Kz 
can be freely chosen for the buckling around the major and minor axes. 

The position of the member axes can be checked in the cross-section graphic in table 1.3 
Cross-Sections (see Figure 2.9, page 14). To access the RSTAB work window, click [View mode]. 
To show the local member axes in the RSTAB work window, you can use the member's context 
menu or the Display navigator. 

 
Figure 2.16: Displaying the member axes in the Display navigator of RSTAB 

If buckling is possible about one or even both member axes, you can enter the buckling length 
coefficients as well as the buckling lengths in the columns D and E respectively F and G. The 
same is possible in the Settings tree. 

To specify the buckling lengths in the work window graphically, click [...]. This button becomes 
available when you click in a KL input field. 

If you define the effective length factor K, the program determines the effective length KL by 
multiplying the member length L by this buckling length coefficient. 

Torsional Buckling 
Column H controls whether a torsional buckling design is to be performed. The effective 
length factors Kx and the torsional buckling lengths KxL can be defined in columns I and J. The 
axis x represents the center line of a member. 

 
Figure 2.17: Member Axes 
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Lateral-Torsional Buckling L.T.B. 
Column K controls whether a lateral torsional buckling design is to be carried out. The lateral-
torsional buckling lengths depend on the settings of table 1.4 Lateral Intermediate Supports. 
There is no possibility to insert a user-defined value here. 

The modification factor Cb for lateral-torsional buckling can be defined in table 1.7 Design  
Parameters (see chapter 2.7).  

Comment 
In the last table column, you can enter user-defined comments for each member to describe, 
for example, the effective member lengths. 

Below the Settings table you find the check box Set inputs for members No. If selected, the set-
tings entered afterwards will be applied to the selected or even to All members. Members can 
be selected by typing the member number or by selecting them graphically using the [] but-
ton. This option is useful when you want to assign the same boundary conditions to several 
members. Please note that settings that have been already defined cannot be changed subse-
quently with this function. 

2.6 Effective Lengths - Sets of Members 
The input table 1.6 controls the effective lengths for sets of members. It is only available if one 
or more sets of members have been selected in table 1.1 General Data. 

 
Figure 2.18: Table 1.6 Effective Lengths - Set of Members 

This table's concept is similar to the one in the previous table 1.5 Effective Lengths - Members. In 
this table, you can enter the effective lengths for the buckling about the two principal axes of 
the set of members as described in chapter 2.5. 

There are differences, however, as far as the parameters for torsional and lateral-torsional 
buckling are concerned. Those are defined by means of specific boundary conditions in table 
1.8 and 1.9 (see chapters 2.8 and 2.9). 
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2.7 Design Parameters 
In this table, several parameters can be defined that are necessary for design. 

 
Figure 2.19: Table 1.7 Design Parameters 

Modification Factor 
In column A, there is the possibility to choose among the three options of the lateral-torsional 
buckling modification factor Cb. The default value is set to 1.0. The Cb factor can also be en-
tered manually or determined by the program according to Equation F1-1 [1], [2].  

Distance Lv 
The distance Lv specifies the distance between the points of maximum and zero shear force 
according to the Section G6 [1], [2]. This applies to round HSS members. 

Gross Area Ag / Net Area An 
In the columns C and D, the gross and net areas of all members are listed. If required, the net 
area can be modified in order to consider holes. 

Shear Lag Factor U 
For every member, the shear lag factor for tension design can be defined according to 
Table D3.1 [1], [2]. 

Effective Area Ae 
Column F lists the effective areas of the members which are determined according to 
Equation D3-1 [1], [2] from the net areas and the shear lag factors. 
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2.8 Nodal Supports - Sets of Members 
This table is only available if you have selected one or more sets of member in table 1.1 General 
Data. 

The stability design of sets of members is carried out according to Chapter C of the ANSI/AISC 
Specification. According to Chapter H of this standard, you can design doubly symmetrical, 
singly symmetrical and unsymmetrical cross-sections stressed by compression and/or bending 
in a plane. For this analysis method, it is necessary to know the amplification factor αcr, of the 
entire set of members to obtain the critical moment. To determine this factor, a planar frame-
work is created with four degrees of freedom for each node which is to be defined in table 1.8. 
This table refers to the current set of members (selected in the add-on module's navigator on 
the left). The calculation of αcr, the bifurcation factor, also depends on the setting in the Details 
dialog box (see chapter 3.1, page 28). 

 
Figure 2.20: Table 1.8 Nodal Supports - Set of Members 

The orientation of axes in the set of members is important for the definition of nodal supports. 
The program checks the position of the nodes and internally defines, according to Figure 2.21 
to Figure 2.24, the axes of the nodal supports for table 1.8. 

 
Figure 2.21: Auxiliary coordinate system for nodal supports - straight set of members 

If all members within the set of members lie on a straight line, the local coordinate system of 
the first member within this set is applied for the entire set of members. 
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Figure 2.22: Auxiliary coordinate system for nodal supports - set of members in vertical plane 

If members of a set of members are not lying in a straight line, they must at least lie in the 
same plane. In Figure 2.22, they are lying in a vertical plane. In this case, the axis X' is horizontal 
and aligned in direction of the plane. The axis Y' is horizontal as well and defined perpendicu-
lar to the axis X'. The axis Z' is directed perpendicularly downwards. 

 
Figure 2.23: Auxiliary coordinate system for nodal supports - set of members in horizontal plane 

If the members of a buckled set of members are lying in a horizontal plane, the axis X' is de-
fined parallel to the X-axis of the global coordinate system. Thus, the axis Y' is set in opposite 
direction to the global Z-axis and the axis Z' is directed parallel to the global Y-axis. 

 
Figure 2.24: Auxiliary coordinate system for nodal supports - set of members in inclined plane 

Figure 2.24 shows the general case of a buckled set of members: The members are not lying in 
one straight line but in an inclined plane. The definition of the axis X' arises out of the intersec-
tion line of the inclined plane with the horizontal plane. Thus, the axis Y' is defined right-
angled to the axis X' and directed perpendicular to the inclined plane. The axis Z' is defined 
perpendicular to the axis X' and Y'. 
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2.9 Member End Releases - Sets of Members 

This table is displayed only if you have selected at least one set of members for the design in 
table 1.1 General Data. Here, you can define releases for members and sets of members that, 
due to structural reasons, do not pass the locked degrees of freedom specified in table 1.8 as 
internal forces. There is also the possibility to exactly define on which side the release is to act 
or to place a release at both sides. 

This table refers to the current set of members (selected in the add-on module's navigator on 
the left). 

 
Figure 2.25: Table 1.9 Member Releases - Set of Members 

In table column B, you define the Member Side to which the release should be assigned. You 
can also connect the releases to both member sides. 

In the columns C to F, you can define releases or spring constants to align the set of members 
model with the support conditions in table 1.8. 
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2.10 Serviceability Data 
The last input table controls several settings for the serviceability design. It is only available if 
you have set relevant entries in the Serviceability Limit State tab of table 1.1 General Data (see 
Figure 2.5, page 11). 

 
Figure 2.26: Table 1.10 Serviceability Data 

In column A, you decide whether you want to apply the deformation to single members, lists 
of members, or sets of members. 

In table column B, you enter the numbers of the members or sets of members that you want to 
design. You can also click [...] to select them graphically in the RSTAB work window. Then, the 
Reference Length appears in column D automatically. This column presets the lengths of the 
members, sets of members, or member lists. If required, you can adjust these values after se-
lecting the Manually check box in column C. 

Table column E defines the governing Direction for the deformation analysis. You can select 
the directions of the local member axes y and z (or u and v for unsymmetrical cross-sections). 

A precamber wc can be taken into account by using entries specified in column F. 

The Beam Type is of vital importance for the correct application of limit deformations. In table 
column G, you can select the girder to be a beam or a cantilever and decide which end should 
have no support. 

The settings of the Details dialog box determine whether the deformations are related to the 
undeformed initial model or to the shifted ends of members or sets of members (see Figure 
3.1, page 28). 
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3. Calculation 
 

3.1 Details 
Before you start the calculation by clicking [Calculation], it is recommended to check the de-
sign details. The corresponding dialog box can be accessed in all tables of the add-on module 
by clicking [Details]. 

 
Figure 3.1: Dialog box Details 

Check of Maximum Effective Slenderness Ratio 
For members designed according to Chapter D [1], [2], the slenderness ratio preferably should 
not exceed 300. This does not apply to the member types "Tension" and "Cable" because they 
are excluded from this check. For members designed according to Chapter E [1], [2], the slen-
derness ratio preferably should not exceed 200. This value is applicable to all members with 
compression or flexure. 

It is possible to set user-defined slenderness ratios for members with tension resp. compres-
sion or flexure. These maximum values are compared with the actual member slendernesses in 
table 3.3 which is available after the calculation (see chapter 4.8) if the corresponding check 
box is selected in the dialog section Display Result Tables. 

Serviceability (Deflections) 
In this section, it is possible to change set the allowable deflection for the serviceability limit 
state design if the default value L/360 is not appropriate. 

The two option fields below control whether the Deformation is to be related to the shifted 
ends of members or sets of members (connection line between start and end nodes of the de-
formed system) or to the undeformed initial system. As a rule, the deformations have to be 
checked relative to the displacements in the entire structural system. 
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Determination of Elastic Critical Moment for LTB 
The elastic critical moment (Mcr) for set of members is calculated automatically. 

Usually, loads act on members (transverse loads). It is important to define where these forces 
are acting on the cross-section: Depending on the Load Application point, transverse loads can 
be stabilizing or destabilizing, and in this way they can critically influence the ideal critical 
moment. 

Limit Load for Special Cases 
It is possible to neglect small stresses due to bending, tension or compression, shear and tor-
sion and, thus, allow a simplified design which eliminates negligible internal forces. In this dia-
log section, the limits of these internal forces or stresses can be entered. Those are defined as 
the ratios between existing internal forces or stresses and the corresponding resistances of 
each cross-section. 

These limit settings are not part of the ANSI/AISC Specification. Changing the limits is in the re-
sponsibility of the program user. 

Cross-Section Optimization 
The optimization is targeted on the maximum design ratio of 100 %. If necessary, you can 
specify a different limit value in this input field. 

Display Results Tables 
In this dialog section, you can select the results tables including parts list that you want to be 
displayed. The tables are described in chapter 4 Results. 

Design Wall Thickness of HSS 
The design wall thickness shall be taken equal to 0.93 times the nominal wall thickness for  
hollow structural sections if the check is set here. This reduction is recommended for electric-
resistance-welded HSS, not for submerged-arc-welded HSS. 

3.2 Start Calculation  
To start the calculation, click the [Calculation] button that is available in all input tables of the 
STEEL AISC add-on module. 

STEEL AISC searches for the results of the load cases, load and result combinations to be de-
signed. If these cannot be found, the program starts the RSTAB calculation to determine the 
design relevant internal forces. 

You can also start the calculation in the RSTAB user interface: In the dialog box To Calculate 
(menu Calculate → To Calculate), design cases of the add-on modules like load cases and load 
combinations are listed. 
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Figure 3.2: To Calculate Dialog box 

If the STEEL AISC design cases are missing in the Not Calculated list, select All or Add-on Mod-
ules in the drop-down list at the end of the list. 

To transfer the selected STEEL AISC cases to the list on the right, use the button []. Click [OK] 
to start the calculation. 

To calculate a design case directly, use the list in the toolbar. Select the STEEL AISC design case 
in the toolbar list, and then click [Show Results]. 

 
Figure 3.3: Direct calculation of a STEEL AISC design case in RSTAB 

Subsequently, you can observe the design process in a separate dialog box. 
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4. Results 
Table 2.1 Design by Load Case is displayed immediately after the calculation. 

 
Figure 4.1: Results table with designs and intermediate values 

The designs are shown in the results tables 2.1 to 2.5, sorted by different criteria. 

The tables 3.1 and 3.2 list the governing internal forces. Table 3.3 informs you about the mem-
ber slendernesses. In the last two results tables, 4.1 and 4.2, parts lists are displayed by mem-
ber and set of members. 

Every table can be selected by clicking the corresponding entry in the navigator. To set the 
previous or next input table, use the buttons shown on the left. You can also use the function 
keys to select the next [F2] or previous [F3] table. 

Click [OK] to save the results. Thus you exit STEEL AISC and return to the main program. 

Chapter 4 Results describes the different results tables one by one. Evaluating and checking re-
sults is described in chapter 5 Results Evaluation, page 41 ff.. 
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4.1 Design by Load Case 
The upper part of this table offers a summery, sorted by load cases, load combinations and re-
sult combinations of the governing designs. Furthermore, this table is divided into Ultimate 
Limit State Design and Serviceability Limit State Design results. 

The lower part of the table contains detailed information on the cross-section characteristics, 
analyzed internal forces and design parameters for the load case selected above. 

 
Figure 4.2: Table 2.1 Design by Load Case 

Description 
This column shows the descriptions of the load cases, load and result combinations used for 
the design. 

Member No. 
This column shows the number of the member that bears the maximum stress ratio of the de-
signed loading. 

Location x 
This column shows the respective x-location where the member's maximum stress ratio oc-
curs. For the table output, the program uses the following member locations x: 

• Start and end node 

• Division points according to possibly defined member division (see RSTAB table 1.6) 

• Member division according to specification for member results (RSTAB dialog box  
Calculation Parameters, tab Global Register Parameters) 

• Extreme values of internal forces 

Design Ratio 
Columns D and E display the design conditions according to the ANSI/AISC Specification [1], 
[2]. The lengths of the colored scale represent the respective utilizations. 
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Design according to Formula 
This column lists the code's equations by which the designs have been performed. 

DS 
The last column contains information on the respective design-relevant design situation (DS): 
ULS (Ultimate Limit State) or SLS (Serviceability Limit State). 

4.2 Design by Cross-Section 

 
Figure 4.3: Table 2.2 Design by Cross-Section 

This table lists the maximum ratios of all members and actions selected for design, sorted by 
cross-section. The results are sorted by cross-section design and serviceability limit state de-
sign. 

If you have a tapered member, both cross-section descriptions are displayed in the table row 
next to the section number. 
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4.3 Design by Set of Members 

 
Figure 4.4: Table 2.3 Design by Set of Members 

This results table is displayed if you have selected at least one set of members for design. The 
table lists the maximum ratios sorted by set of members. 

The Column Member No. shows the number of the one member within the set of members 
that bears the maximum ratio for the individual design criteria. 

The output by set of members clearly presents the design for an entire structural group (for 
example a frame). 
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4.4 Design by Member 

 
Figure 4.5: Table 2.4 Design by Member 

This results table presents the maximum ratios for the individual designs sorted by member 
number. The columns are described in detail in chapter 4.1 on page 32. 

4.5 Design by x-Location 

 
Figure 4.6: Table 2.5 Design by x-Location 
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This results table lists the maxima for each member at the locations x resulting from the divi-
sion points defined in RSTAB: 

• Start and end node 

• Division points according to possibly defined member division (see RSTAB table 1.6) 

• Member division according to specification for member results (RSTAB dialog box  
Calculation Parameters, tab Global Register Parameters)  

• Extreme values of internal forces 

4.6 Governing Internal Forces by Member 

 
Figure 4.7: Table 3.1 Governing Internal Forces by Member 

This table displays for each member the governing internal forces that result in maximum 
stress ratios in each design. 

Location x 
At this x location of the member, the respective maximum design ratio occurs. 

Load Case 
This column displays the number of the load case, the load combination or result combination 
whose internal forces produce maximum stresses. 

Forces / Moments 
For each member, this column displays the axial and shear forces as well as the torsional and 
bending moments producing maximum design ratios in the respective ultimate limit state and 
serviceability limit state designs. 

Design According to Formula 
The final column informs you about the design types and the equations by which the designs 
according to [1] or [2] have been performed. 



4  Results 

 37 Program STEEL AISC © 2013 by Dlubal Engineering Software 

 

4.7 Governing Internal Forces by Set of Members 

 
Figure 4.8: Table 3.2 Governing Internal Forces by Set of Members 

This table contains the internal forces that result in the maximum ratios within the design of 
each set of members. 
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4.8 Member Slendernesses 

 
Figure 4.8: Table 3.3 Member Slendernesses 

This results table is shown only if you have selected the respective check box in the Details dia-
log box (see Figure 3.1, page 28). 

The table lists the effective slendernesses of the designed members for both directions of the 
principal axes. They were determined depending on the type of load. At the end of the list, you 
find a comparison with the limit values that have been defined in the Details dialog box. 

Members of the member type "Tension" or "Cable" are not included in this table. 

This table is displayed only for information. No design of the slendernesses is intended. 



4  Results 

 39 Program STEEL AISC © 2013 by Dlubal Engineering Software 

 

 

 

4.9 Parts List by Member 
Finally, STEEL AISC provides a summary of all members that are included in the design case. 

 
Figure 4.9: Table 4.1 Parts List by Member 

By default, this list contains only the designed members. If you need a parts list for all members 
of the model, select the corresponding option in the Details dialog box, tab Other (see Figure 
3.1 on page 28). 

Part No. 
The program automatically assigns item numbers to similar members. 

Cross-Section Description 
This column lists the cross-section numbers and descriptions. 

Number of Members 
This column shows how many similar members are used for each part. 

Length 
This column displays the respective length of an individual member. 

Total Length 
This column shows the product determined from the two previous columns. 

Surface Area 
For each part, the program indicates the surface area related to the total length. The surface 
area is determined from the Surface Area of the cross-sections that can be seen in tables 1.3 
and 2.1 to 2.5 in the cross-section information (see Figure 2.11, page 16). 
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Volume 
The volume of a part is determined from the cross-sectional area and the total length. 

Cross-Section Mass 
The Cross-Section Mass is related to the length of one meter. For tapered cross-sections, the 
program averages both cross-section properties. 

Mass 
The values of this column are determined from the respective product of the entries in column 
C and G. 

Total Mass 
The final column indicates the total mass of each part. 

Sum 
At the bottom of the list, you find a summary of the summed up values of column B, D, E, F, 
and I. The last data field of the column Total Mass gives information about the total amount of 
steel required. 

4.10 Parts List by Set of Members 

 
Figure 4.10: Table 4.2 Parts List by Set of Members 

The last results table is displayed if you have selected at least one set of members for design. 
The table summarizes an entire structural group (for example a horizontal beam) in a parts list. 

Details on the various columns can be found in the previous chapter. If different cross-sections 
are used in the set of members, the program averages the surface area, the volume, and the 
cross-section mass. 
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5. Results Evaluation 
The design results can be evaluated in different ways. For this, the buttons in the results tables 
are very useful which are located below the upper tables.  

 
Figure 5.1: Buttons for results evaluation 

These buttons have the following functions: 

Button Description Function 

 
Ultimate Limit State  
Designs 

Turns on and off the results of the ultimate limit 
state design 

 
Serviceability Limit State 
Designs 

Turns on and off the results of the serviceability 
limit state design 

 Show Color Bars 
Turns on and off the colored reference scales in  
the results tables 

 Show Rows with Ratio > 1 
Displays only the rows where the ratio is more  
than 1, and thus the design is failed 

 Result Diagrams 
Opens the window Result Diagram on Member 
 chapter 5.2, page 44 

 Excel Export 
Exports the table to MS Excel / OpenOffice 
 chapter 7.4.3, page 54 

 Member Selection 
Allows you to graphically select a member to dis-
play its results in the table 

 View Mode 
Jumps to the RSTAB work window to change the 
view 

Table 5.1: Buttons in results tables 2.1 to 2.5 
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5.1 Results in the RSTAB Model 
To evaluate the design results, you can also use the RSTAB work window. 

RSTAB background graphic and view mode 
The RSTAB work window in the background is useful for finding the position of a particular 
member in the model: The member selected in the STEEL AISC results table is highlighted in 
the selection color in the background graphic. Furthermore, an arrow indicates the member's 
x-location that is displayed in the selected table row. 

 
Figure 5.2: Indication of the member and the current Location x in the RSTAB model 

In case you cannot improve the display by moving the STEEL AISC module window, click 
[Jump to Graphic] to activate the View Mode: The program hides the module window so that 
you can modify the display in the RSTAB user interface. The view mode provides the functions 
of the View menu, for example zooming, moving, or rotating the display. The pointer remains 
visible. 

Click [Back] to return to the add-on module STEEL AISC. 

RSTAB work window 
The ratios can also be checked graphically in the RSTAB model. Click [Graphics] to exit the de-
sign module. The ratios are displayed in the RSTAB work window like internal forces of a load 
case. 

To turn the display of design results on or off, use the [Show Results] button known from the 
display of internal forces in RSTAB. To display the result values, use the toolbar button [Show 
Values] to the right. 

As the RSTAB tables are of no relevance for the evaluation of design results, you can hide them. 

 The design cases can be set by means of the list in the RSTAB menu bar. 
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The graphical representation of the results can be controlled in the Display navigator by select-
ing Results → Members. The display of ratios is Two-Colored by default. 

 

Figure 5.3: Display navigator: Results → Members 

In case of a multicolor representation (options With/Without Diagram or Cross-Sections), the 
color panel is available, providing common control functions. The functions are described in 
detail in the RSTAB manual, chapter 3.4.6. 

 

Figure 5.4: Design ratios with display option Without Diagram 

This graphics of the design results can be transferred to the printout report (see chapter 6.2, 
page 47). 

You can return to the STEEL AISC module by clicking the panel button [STEEL AISC]. 
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5.2 Result Diagrams 
You can also evaluate a member's result distributions in the result diagram graphically. 

To do this, select the member (or set of members) in the STEEL AISC results table by clicking in 
the table row of the member. Then open the dialog box Result Diagram on Member by clicking 
the button shown on the left. The button is at the bottom of the upper results table (see Figure 
5.1, page 41). 

The result diagrams are available in the RSTAB graphic. To display the diagrams, click 

Results → Result Diagrams for Selected Members 

or use the button in the RSTAB toolbar shown on the left. 

A window opens, graphically showing the distribution of the maximum design values on the 
member or set of members. 

 
Figure 5.5: Dialog box Result Diagram on Member 

Use the list in the toolbar above to choose the relevant STEEL AISC design case.  

The dialog box Result Diagram on Member is described in detail in the RSTAB manual, chapter 
9.5. 
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5.3 Filter for Results 
The STEEL AISC results tables allow you to sort the results by various criteria. In addition, you 
can use the filter options described in chapter 9.7 of the RSTAB manual to evaluate the design 
results graphically. 

You can use the option Visibility also for STEEL AISC (see RSTAB manual, chapter 9.7.1) to filter 
the members in order to evaluate them. 

Filtering designs 
The design ratios can easily be used as filter criteria in the RSTAB work window, which can be 
accessed by clicking [Graphics]. To apply this filter function, the panel must be displayed. If the 
panel is not active, click 

View → Control Panel (Color Scale, Factors, Filter) 

or use the toolbar button shown on the left. 

The panel is described in the RSTAB manual, chapter 3.4.6. The filter settings for the results 
must be defined in the first panel tab (Color spectrum). As this register is not available for the 
two-colored results display, you have to use the Display navigator and set the display options 
Colored With/Without Diagram or Cross-Sections first. 

 
Figure 5.6: Filtering design ratios with adjusted color spectrum 

As the figure above shows, the color spectrum can be set in such a way that only ratios higher 
than 0.50 are shown in a color range between blue and red. 

If you select the option Display Hidden Result Diagram in the Display navigator (Results →  
Members), you can display all stress ratio diagrams that are not covered by the color spectrum. 
Those diagrams will be represented by dotted lines.  
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Filtering members 
In the Filter tab of the control panel, you can specify the numbers of particular members to 
display their results exclusively, that is, filtered. This function is described in detail in the RSTAB 
manual, chapter 9.7.3. 

 

Figure 5.7: Member filter for the stress ratios of a hall frame 

Unlike the partial view function, the model is now displayed completely in the graphic. The 
figure above shows the design ratios of a hall frame. The remaining members are displayed in 
the model but are shown without design ratios.
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6. Printout 
 

6.1 Printout Report 
Similar to RSTAB, the program generates a printout report for the STEEL AISC results, to which 
graphics and descriptions can be added. In the printout report, you can select the data from 
the design module to be included in the printout. 

The printout report is described in the RSTAB manual. In particular, chapter 10.1.3.4 Selecting 
Data of Add-on Modules provides information concerning the selection of input and output da-
ta in add-on modules for the printout. 

For large structural systems with many design cases, it is recommended to split the data into 
several printout reports, thus allowing for a clearly-arranged printout. 

6.2 STEEL AISC Graphic Printout  
In RSTAB, every picture that is displayed in the work window can be included in the printout 
report or send directly to a printer. Thus, the design ratios displayed in the RSTAB model can 
be prepared for the printout, too. 

The printing of graphics is described in the RSTAB manual, chapter 10.2. 

Designs in the RSTAB model 
To print the currently displayed graphic of the design ratios, click 

File → Print Graphic 

or use the toolbar button shown on the left. 

 
Figure 6.1: Button Print Graphic in RSTAB toolbar 

Result Diagrams 
You can also transfer the Result Diagram on Member to the report by using the [Print] button. It 
is also possible to print it directly. 

 
Figure 6.2: Button Print Graphic in the dialog box Result Diagram on Member 

The dialog box Graphic Printout opens (see following page). 
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Figure 6.3: Dialog box Graphic Printout, tab General 

This dialog box is described in the RSTAB manual, chapter 10.2. The RSTAB manual also de-
scribes the Options and Color Spectrum tab. 

A graphic can be moved anywhere within the printout report by using the drag-and-drop 
function. 

To adjust a graphic subsequently in the printout report, right-click the relevant entry in the 
navigator of the printout report. The option Properties in the context menu opens the dialog 
box Graphic Printout, offering various options for adjustment. 

 
Figure 6.4: Dialog box Graphic Printout, tab Options
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7. General Functions 
This chapter describes useful menu functions as well as export options for the designs. 

7.1 Design Cases 
Design cases allow you to group members for the design: In this way, you can combine groups 
of structural components or analyze members with particular design specifications (for exam-
ple changed materials, partial safety factors, optimization). 

It is no problem to analyze the same member or set of members in different design cases. 

To calculate a STEEL AISC design case, you can also use the load case list in the RSTAB toolbar. 

Create New Design Case 
To create a new design case, use the STEEL AISC menu and click 

File → New Case. 

The following dialog box appears: 

 
Figure 7.1: Dialog box New STEEL AISC Case 

In this dialog box, enter a No. (one that is still available) for the new design case. The corre-
sponding Description will make the selection in the load case list easier. 

Click [OK] to open the STEEL AISC table 1.1 General Data where you can enter the design data. 

Rename a Design Case 
To change the description of a design case, use the STEEL AISC menu and click 

File → Rename Case. 

The following dialog box appears: 

 
Figure 7.2: Dialog box Rename STEEL AISC Case 

In this dialog box, you can define a different Description as well as a different No. for the design 
case. 
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Copy a Design Case 
To copy the input data of the current design case, use the STEEL AISC menu and click 

File → Copy Case. 

The following dialog box appears: 

 
Figure 7.3: Dialog box Copy STEEL AISC Case 

Define the No. and, if necessary, a Description for the new case. 

Delete a Design Case 
To delete design cases, use the STEEL AISC menu and click 

File → Delete Case. 

The following dialog box appears: 

 
Figure 7.4: Dialog box Delete Cases 

The design case can be selected in the list Available Cases. To delete the selected case, click 
[OK]. 
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7.2 Cross-Section Optimization 
The design module offers you the option to optimize overloaded or little utilized cross-
sections. To do this, select in column D of the relevant cross-sections in table 1.3 Cross-Sections 
whether to determine the cross-section From the current row or the user-defined Favorites (see 
Figure 2.9, page 14). You can also start the cross-section optimization in the results tables by 
using the context menu 

 
Figure 7.5: Context menu for cross-section optimization 

During the optimization process, the module determines the cross-section within the same 
cross-section table that fulfills the analysis requirements in the most optimal way, that is, 
comes as close as possible to the maximum allowable stress ratio specified in the Details dialog 
box (see Figure 3.1). The required cross-section properties will be determined with the internal 
forces from RSTAB. If another cross-section proves to be more favorable, this cross-section will 
be used for the design. Then, the graphic in table 1.3 will show two cross-sections: the original 
cross-section from RSTAB and the optimized one (see Figure 7.7). 

For a parameterized cross-section, the dialog box Optimization appears if you select the corre-
sponding check box. 

 
Figure 7.6: Dialog box Welded Cross-Sections - I symmetric : Optimize 

By selecting the check boxes in the Optimize column, you decide which parameter(s) you want 
to modify. This enables the Minimum and Maximum columns, where you can specify the upper 
and lower limits of the parameter. The Increment column determines the interval in which the 
size of the parameter varies during the optimization process. 
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If you want to Keep current side proportions, select the corresponding check box. In addition, 
you have to select at least two parameters for optimization. 

Cross-sections based on combined rolled cross-sections cannot be optimized. 

Please note for the optimization process that the internal forces will not be recalculated auto-
matically with the changed cross-sections: It is up to you to decide which thicknesses or cross-
sections should be transferred to RSTAB for recalculation. As a result of optimized cross-
sections, internal forces may vary significantly because of the changed stiffnesses in the struc-
tural system. Therefore, it is recommended to recalculate the internal forces of the modified 
cross-section data after the first optimization, and then to optimize the cross-sections once 
again. 

The modified cross-sections can be exported to RSTAB: Set table 1.3 Cross-Sections, and then 
click 

Edit → Export All Cross-Sections to RSTAB. 

The context menu in table 1.3 provides options to export optimized cross-sections to RSTAB. 

 
Figure 7.7: Context menu in table 1.3 Cross-Sections 

Before the modified cross-sections are transferred to RSTAB, a security query appears as to 
whether the results of RSTAB should be deleted. 

 
Figure 7.8: Query before transfer of modified cross-sections to RSTAB 
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By confirming the query and starting the [Calculation] subsequently in the STEEL AISC add-on 
module, the RSTAB internal forces as well as the designs will be determined in one single cal-
culation run. 

If the modified cross-sections have not been exported to RSTAB yet, you can import the origi-
nal cross-sections in the design module by using the options shown in Figure 7.7. Please note 
that this option is only available in table 1.3 Cross-sections. 

If you optimize a tapered member, the program modifies the member start and end. Then it 
linearly interpolates the second moments of area for the intermediate locations. As these mo-
ments are considered with the fourth power, the designs may be inaccurate if the depths of 
the start and end cross-section differ considerably. In such a case, it is recommended to divide 
the taper into several members, thus manually modeling the taper layout. 

7.3 Units and Decimal Places 
Units and decimal places for RSTAB and the add-on modules are managed in one dialog box. 
In STEEL AISC, you can use the menu to define the units. To open the corresponding dialog 
box, click 

Settings → Units and Decimal Places. 

The program opens the following dialog box that you already know from RSTAB. STEEL AISC 
will be preset in the list Program / Module. 

 
Dialog box Units and Decimal Places 

The settings can be saved as user profile to reuse them in other models. These functions are 
described in the RSTAB manual, chapter 11.1.3. 
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7.4 Data Transfer 
7.4.1 Export Material to RSTAB 
If you have adjusted the materials in STEEL AISC for design, you can export the modified mate-
rials to RSTAB in a similar manner as you export members and cross-sections: Open table 1.2 
Materials, and then click 

Edit → Export All Materials to RSTAB. 

The modified materials can also be exported to RSTAB by using the context menu of table 1.2. 

 
Figure 7.9: Context menu of table 1.2 Materials 

Before the modified materials are transferred to RSTAB, a security query appears as to whether 
the results of RSTAB should be deleted. After you confirm the query and start the [Calculation] 
subsequently in STEEL AISC, the RSTAB internal forces and designs will be determined in one 
single calculation run. 

If the modified materials have not been exported to RSTAB yet, you can transfer the original 
materials to the design module, using the options shown in Figure 7.9. Please note, however, 
that this option is only available in table 1.2 Materials. 

7.4.2 Export Effective Lengths to RSTAB 
If you have adjusted the materials in STEEL AISC for design, you can export the modified mate-
rials to RSTAB in a similar manner as you export cross-sections: Open table 1.5 Effective Lengths 
- Members, and then click 

Edit → Export All Effective Lengths to RSTAB. 

The modified effective lengths can also be exported to RSTAB via the context menu of table 1.5. 

 
Figure 7.10: Context menu of table 1.5 Effective Lengths - Members 

Before the modified materials are transferred to RSTAB, a security query appears as to whether 
the results of RSTAB should be deleted. 

If the modified effective lengths have not been exported to RSTAB yet, you can retransfer the 
original effective lengths to the design module, using the options shown in Figure 7.10. Please 
note, however, that this option is only available in table 1.5 Effective Lengths - Members and 1.6 
Effective Lengths - Sets of Members. 

7.4.3 Export Results 

The STEEL AISC results can also be used by other programs. 

Clipboard 
To copy cells selected in the results tables to the Clipboard, press the keys [Ctrl]+[C]. To insert 
the cells, for example in a word-processing program, press [Ctrl]+[V]. The headers of the table 
columns will not be transferred. 
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Printout report 
The data of the STEEL AISC add-on module can be printed into the global printout report (see 
chapter 6.1, page 47) for export. Then, in the printout report, click 

File → Export to RTF. 

The function is described in the RSTAB manual, 10.1.11. 

Excel / OpenOffice 
STEEL AISC provides a function for the direct data export to MS Excel, OpenOffice.org Calc or 
the file format CSV. To open the corresponding dialog box, click 

File → Export Tables. 

The following export dialog box appears 

 
Figure 7.11: Dialog box Export - MS Excel 

When you have selected the relevant parameters, you can start the export by clicking [OK].  
Excel or OpenOffice will be started automatically, that is, the programs do not have to be 
opened first. 

 
Figure 7.12: Results in Excel 
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8. Example 
 

Column with Biaxial Bending 

In this example, the stability design of buckling and lateral buckling is carried out by analyzing the 
relevant interaction conditions. The calculation described below follows the Load and Resistance 
Factor Design provisions. 

Design values 

System and loads 

 

Figure 8.1: System and design loads (γ-fold) 

Internal forces according to linear static analysis  

             
  Pr Mry Mrz Vry Vrz 

Figure 8.2: Internal Forces 

w 

2 m 

2 m 

V 

P 

z 

y 

W 8x24 

Design values of static loads: 

P = 300 kN 
w = 5.0 kN/m 
V = 7.5 kN 
 
Cross-section: W 8x24 
 
Material:  ASTM A36 

4 m 
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Design location (decisive location x) 

The design is performed for all locations x (see chapter 4.5) of the member. The following in-
ternal forces act in the decisive location at x = 2.00 m:  

Pr = –300.00 kN      Mry = 10.00 kNm      Mrz = 7.50 kNm      Vry = 3.75 kN      Vrz = 0.00 kN 

Cross-section properties W 8x24, A36 

 Property Symbol Value  Unit 

 Gross area of cross-section Ag 45.677 cm2 

 Moment of inertia Iy 3446.40 cm4 

 Moment of inertia Iz 761.70 cm4 

 Radius of inertia ry 8.687 cm 

 Radius of inertia  rz 4.089 cm 

 Cross-section weight G  35.9 kg/m 

 Moment of torsional rigidity J 14.57 cm4 

 Warping moment of inertia Cw   69550.80 cm6 

 Elastic cross-section modulus Sy  342.49 cm3 

 Elastic cross-section modulus Sz 92.26 cm3 

 Plastic cross-section modulus Zy  380.18 cm3 

 Plastic cross-section modulus Zz 140.44 cm3 

Classification of cross-section – Table B4.1 

Compression 

Flange 

Case 3 – Uniform compression in flanges of rolled I-shaped section: 

119.816.10/49.82t/b ==  

A/Np =λ  

894.152.248/19993856.0F/E56.0 yr ===λ  

Flange is NonCompact in compression. 

Web 

Case 10 – Uniform compression in web of doubly symmetric rolled I-shaped section: 

02.2522.6/7.155t/h w ==  

A/Np =λ  

29.422.248/19993849.1F/E49.1 yr ===λ  

Web is NonCompact in compression. 

The section is NonCompact in compression. 
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Flexure 

Case 1 – Flexure in flanges of rolled I-shaped section: 

119.816.10/49.82t/b ==  

785.102.248/19993838.0F/E38.0 yp ===λ  

382.282.248/1999380.1F/E0.1 yr ===λ  

Flange is Compact in flexure. 

Case 9 – Flexure in web of doubly symmetric rolled I-shaped section: 

02.2522.6/7.155t/h w ==  

717.1062.248/19993876.3F/E76.3 yp ===λ  

779.1612.248/1999387.5F/E7.5 yr ===λ  

Web is Compact in flexure. 

The section is Compact in flexure. 

Chapter E 

Buckling about minor axis (⊥ to z-z Axis)  

Check slenderness ratio: 

953.97
89.40

40000.1
r

LK

z

z =
⋅

=     

Check limit: 

73.133
2.248

199938.0
71.4

F
E

71.4
y

=⋅=  

Calculate the elastic critical buckling stress Fe: 

MPa665.205

89.40
40000.1

199938

r

LK

E
Fe

2

2

2

z

z

2

=







 ⋅

⋅π
=










π
=  

Calculate flexural buckling stress Fcr,z: 

Because 
yz

z

F
E

71.4
r

LK
≤  

MPa773.1492.248658.0F658.0F 665.205

2.248

y
F

F

z,cr
e

y

=⋅











=⋅
















=  

Nominal compressive strength Pn,z: 

kN12.684N1206847.4567773.149AgFP z,crz,n ==⋅=⋅=  

Design compressive strength 

kN71.61512.6849.0P z,nc =⋅=⋅φ  

Design ratio 

487.0
12.6849.0

300
P

P

z,nc

r
z =

⋅
=

⋅φ
=η   - OK, decisive 
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Chapter E 

Buckling about major axis (⊥ to y-y Axis)  

Check slenderness ratio: 

05.46
87.86

40000.1
r

LK

y

y =
⋅

=  

Check limit: 

73.133
2.248

199938.0
71.4

F
E

71.4
y

=⋅=  

 
Calculate the elastic critical buckling stress Fe: 

MPa55.930

87.86
40000.1

199938

r

LK

E
Fe

2

2

2

y

y

2

=







 ⋅

⋅π
=












π
=  

Calculate flexural buckling stress Fcr,y: 

Because 
yy

y

F
E

71.4
r

LK
≤  

MPa981.2212.248658.0F658.0F 55.930

2.248

y
F

F

y,cr
e

y

=⋅











=⋅
















=  

Nominal compressive strength Pn,y: 

kN95.1013N95001317.4567981.221AFP gy,cry,n ==⋅=⋅=  

Design compressive strength 

kN56.91295.10139.0P y,nc =⋅=⋅φ  

Design ratio 

328.0
95.10139.0

300
P

P

y,nc

r
y =

⋅
=

⋅φ
=η   - OK 

Chapter F 

I-shaped member bent about major axis  

Note: The nominal flexural strength Mn,y, shall be the lower value obtained according to the 
limit states of yielding (plastic moment) and lateral-torsional buckling. 

1. Yielding 

Calculate the nominal flexural strength Mn,y:  

kNm36.94Nmm676360943801802.248ZFMM yyy,py,n ==⋅===  

Design flexural strength 

kNm92.8436.949.0M y,nb =⋅=⋅φ  

Design ratio 

117.0
92.84

10
M

M

y,nb

y,r
y,b ==

⋅φ
=η   - OK 
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2. Lateral-torsional buckling 

Note: The calculation of lateral-torsional buckling modification factor Cb is based on 
  formula F1-1. 

Calculate Cb: 

0.3R
M3M4M3M5.2

M5.12
C m

CBAmax

max
b ≤

+++
=  

0.30.1
5.731045.73105.2

105.12
Cb ≤⋅

⋅+⋅+⋅+⋅
⋅

=  

0.3136.1Cb ≤=  

Limiting lengths Lp and Lr: 

mm9.2039
2.248

0.199938
89.4076.1

F
E

r76.1L
y

yp =⋅⋅==  

=







++=

2
0yy

0yy
tsr Jc

hS

E

F7.0
76.60.10.1

hS
Jc

F7.0
E

r95.1L  

=







⋅

++
⋅

=
2

0yy

0yyy

wz

0.1J

hS

E

F7.0
76.60.10.1

hS
0.1J

F7.0
E

S

C.I
95.1  

⋅
⋅⋅

⋅⋅
=

2.191342490
145700

2.2487.0
199938

342490
108.695507617000

95.1
6

 

 mm9.7597
145700

2.191342490
199938

2.2487.0
76.60.10.1

2

=





 ⋅⋅
⋅++⋅  

Check limit: 

pL < LrLb ≤    - formula (F2-2)  

Calculate the nominal flexural strength Mn,y: 

( ) y,p
pr

pb
yyy,py,pby,n M

LL

LL
SF7.0MMCM ≤
























−

−
−−=  

( ) Nmm1036.94
9.20399.7597

9.20394000
3424902.2487.01036.941036.94136.1M 666

y,n ⋅≤















−
−

⋅⋅⋅−⋅−⋅⋅=

kNm26.93Nmm1026.93M 6
y,n =⋅=  

Design flexural strength 

kNm93.8326.939.0M y,nb =⋅=⋅φ  

Design ratio 

119.0
93.83

10
M

M

y,nb

y,r
y,b ==

⋅φ
=η   - OK, decisive 
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I-shaped member bent about minor axis  

Note: The nominal flexural strength Mn,z, shall be the lower value obtained according to the 
limit states of yielding (plastic moment) and flange local buckling. 

1. Yielding 

Calculate the nominal flexural strength Mn,z:  

zyzyz,pz,n SF6.1ZFMM ⋅≤==  

kNm86.34Nmm208857341404402.248ZF zy ==⋅=  

kNm64.36922602.2486.1SF6.1 zy =⋅⋅=⋅  

kNm86.34M z,p =  

Design flexural strength 

kNm37.3186.349.0M z,nb =⋅=⋅φ  

Design ratio 

239.0
37.31
5.7

M

M

z,nb

z,r
z,b ==

⋅φ
=η   - OK 

2. Flange local buckling 

For section with compact flanges, the limit state of yielding shall apply.  

Chapter G 

Shear in the major axis  

Note: The nominal shear strength Vn,y of unstiffened or stiffened webs is calculated according to 
the limit states of shear yielding and shear buckling 

Calculate the nominal shear strength Vn,y:  

y,wvyy,n ACF6.0V ⋅=  

2.1k v =  

Check limit: 

yvf F/Ek10.1t/b ⋅≤  

2.34119.8 ≤  

if true 0.1Cv =  

Shear area Aw,y: 

2
ffy,w mm25.335216.1097.1642tb2A =⋅⋅=⋅=  

after 

kN22.499N22049925.33520.12.2486.0V y,n ==⋅⋅⋅=  

Design shear strength 

m/kN22.49922.4990.1V y,nv =⋅=⋅φ  

Design ratio 

007.0
22.499

75.3
V

V

y,nb

y,r
y,v ==

⋅φ
=η   - OK 
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Chapter H 

H1. Interaction of flexure and compression in doubly symmetric members 

 Check limit: 

2.0
P

P
P
P

y,nc

r

c

r ≥
⋅φ

=  

2.0487.0 ≥    - true, then formula (H1-1a)  

Interaction formula: 

0.1
M

M

M

M

9
8

P

P

z,c

z,r

y,c

y,r

c

r ≤









++  

0.1
M

M

M

M

9
8

P

P

z,nb

z,r

y,nb

y,r

y,nc

r ≤










⋅φ
+

⋅φ
+

⋅φ
 

0.1
86.349.0

5.7
26.939.0

10
9
8

12.6849.0
300

≤







⋅
+

⋅
+

⋅
 

 ( ) 0.1239.0119.0
9
8

487.0 ≤++  

0.1805.0 ≤   - OK 
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